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DRV2603 ERM/LRA Haptic Driver Evaluation Kit

The DRV2603 is a haptic driver designed to control Linear Resonant Actuators (LRA) and Eccentric
Rotating Mass (ERM) motors. The DRV2603 provides many features which help eliminate the design
complexities of haptic motor control including reduced solution size, high efficiency output drive, simplified
control signaling, quick device startup, and auto-resonance frequency tracking.

The DRV2603EVM-CT Evaluation Module (EVM) is a complete demo and evaluation platform for the
DRV2603. The kit includes a microcontroller, linear actuator, eccentric rotating mass motor, samples
waveforms and capacitive touch buttons which can be used to completely demonstrate and evaluate the
DRV2603.

This document contains instructions for setup and operation of the DRV2603EVM-CT, as well as an in-
depth description and examples of haptic waveforms for LRA and ERM actuators.

Evaluation Kit Contents:
• DRV2603EVM-CT Demo and Evaluation board

• Mini-USB Cable

Needed for programming and advanced configuration:

• Code Composer Studio™ (CCS) or IAR Embedded Workbench IDE for MSP430

• EZ430-F2013, MSP430 LaunchPad (MSP-EXP430G2), or MSP430-FET430UIF hardware
programming tool

• DRV2603EVM-CT Firmware

Code Composer Studio is a trademark of Texas Instruments.
I2C is a trademark of N.B.X Corporation.
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1 Getting Started

The DRV2603 can be used as a demonstration or evaluation tool. When the DRV2603EVM-CT Evaluation
Module is powered on, a demo application automatically starts. To power the board, connect the
DRV2603EVM-CT to an available USB port on your computer using the included mini-USB cable. The
demo begins with a board power-up sequence and then will enter the demo effects mode. The four larger
buttons (B1-B4) can be used to sample haptic effects using both the ERM and LRA motor in the top right
corner. The two smaller mode buttons (“–“, “+”) are used to change between the different sets of effects.
See the DRV2603 Demonstration Program section for a more detailed description of the demo application.

Figure 1. Board Diagram
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1.1 Evaluation Module Operating Parameters

The following table lists the operating conditions for the DRV2603 on the evaluation module.

Parameter Specification

Supply voltage range 2.5V to 5.2V

Power-supply Current Rating 400mA

External PWM Voltage, VPWM (optional) 1.8V to VDD

1.2 Quick Start Board Setup

The DRV2603EVM-CT firmware contains haptic effects which showcase the features and benefits of the
DRV2603. Follow the instructions below to begin the demo.

1. Out of the box, the jumpers are set to begin demo mode using USB power. The default jumper settings
can be found in the table below.

Jumper Default Position Description

JP1 Shorted Connect MSP430 PWM output to DRV2603 PWM input

JP2 Shorted 3.3V reference for I2C

JP3, JP4 Shorted Connect on-board actuators to DRV2603

MSP USB to MSP Select USB (5V) or VBAT power for the MSP430

DRV USB to DRV Select USB (5V) or VBAT power for the DRV2603

2. Connect the included mini-USB cable to the USB connector on the DRV2603EVM-CT board.

3. Connect the other end of the USB cable to an available USB port on a computer, USB charger, or USB
battery pack.

4. If the board is powered correctly the four colored LEDs will light up, the four mode LEDs will flash, and
the LRA and ERM will play an effect, indicating the board has been successfully initialized.
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2 DRV2603 Demonstration Program

The DRV2603EVM-CT demo contains haptic effects which showcase the features and benefits of the
DRV2603. The sections below provide a detailed description of the included effects.

2.1 Modes and Effects Table

The effects preloaded on the DRV2603EVM-CT are listed in Table 1. The modes are selected using the
“+” and “–“ mode buttons in the center of the board. The current mode can be identified by the white LEDs
directly above the mode buttons. Buttons B1-B4 trigger the effects listed in the description column and will
change based on the selected mode.

Table 1. Mode and Effects Table

Mode Button Description Actuator Mode

B1 Ramp-up and click LRA
(Auto-Resonance On)B2 Click and Ramp-downMode 0

LEDs Off B3 Ramp-up and click
ERM

B4 Click and Ramp-down

LRAB1 LRA Alert (Buzz) (Auto-Resonance On)

LRAMode 1 B2 LRA Alert (Buzz) (Auto-Resonance Off)LED M4 On
B3 ERM Alert (Buzz) ERM

B4 LED Flash (Visual Alert Only) –

B1 Click with braking

B2 Click no brakingMode 2 LRA
LED M3 On (Auto-Resonance On)B3 Double-click with braking

B4 Double-click no braking

B1 Keyboard Click (Click with braking)

B2 Spacebar Effect (Click and Release)Mode 3 LRA (Auto-Resonance On)LED M2 On B3 Backspace Effect (Double-tick)

B4 Scroll Wheel Effect

B1 Click with braking

B2 Click no brakingMode 4 ERMLED M1 On B3 Double-click with braking

B4 Double-click no braking

B1

B2Mode 5 ERM and LRAConcentration GameLED M0 On (Auto-Resonance On)B3

B4

2.2 Description of the Modes

The modes above were created to showcase various benefits of the DRV2603. See the description of
each mode below for more details.

2.2.1 Mode 0 – Ramp and Fade Waveforms

Mode 0 is ramp effects which demonstrate transitional effect capabilities of both LRAs and ERMs.

2.2.2 Mode 1 – Buzz and Alerts

Mode 1 demonstrates an LRA with auto-resonance on, an LRA with auto-resonance off, and an ERM.
Compare the difference in strength between the LRA with and without auto-resonance.
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Figure 2 and Figure 3 compare the acceleration (in blue) between a driver without auto-resonance
detection and a driver with auto-resonance detection.

Figure 2. LRA Auto-Resonance Off Figure 3. LRA Auto-Resonance On

2.2.3 Mode 2 – LRA Clicks

Mode 2 showcases LRA clicks and double clicks. Notice the difference in length of the click with braking
and without braking. Then compare the double clicks and notice the event separation is only possible with
braking.

Figure 4 and Figure 5 show the difference between a click with braking and a click without braking. Notice
the acceleration (in blue) is much longer when braking is not applied.

Figure 4. LRA Click without Braking Figure 5. LRA Click with Braking

2.2.4 Mode 3 – User Interface Effects

Mode 3 showcases LRA user interface effects.

1. Button 1 – Basic click effect

2. Button 2 – Click and Release effect – when holding the board press this button. The button will click
when pressed down and bump when released giving a full button effect.

3. Button 3 – Double tick effect – the double tick effect can be used for a backspace key or some other
special function key.

4. Button 4 – Scroll wheel effect – press this button while holding the board and feel the scroll-like effect
imitating a flick or scroll gesture.
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Figure 6. LRA Click and Release Effect Figure 7. LRA Scroll Wheel Effect

2.2.5 Mode 4 – ERM Clicks

Mode 4 showcases ERM clicks and double clicks. Similarly to the LRA, compare the click with braking and
without braking and notice the sharper feel with braking.

2.2.6 Mode 5 – Concentration Game

Mode 5 is a game that incorporates the various LRA and ERM effects. This can be used to demonstrate
haptics in a real application.

To begin playing Concentration:

1. Press any of the large effect buttons.

2. The game will then count down.

3. Once the countdown completes, a button will light and an effect will play.

4. Repeat the pattern by pressing the same button.

5. After each successfully repeated pattern, the board will repeat the same pattern and add one
additional button to the sequence.

3 Hardware Configuration

The DRV2603EVM-CT is very flexible and can be used to completely evaluate the DRV2603. The
following sections list the various hardware configurations.

3.1 Input and Output Overview

The DRV2603EVM-CT allows complete evaluation of the DRV2603 though test points, jacks and
connectors. Table 2 gives a brief description of the hardware.

Table 2. Hardware Overview

Signal Description I/O

PWM External DRV2603 PWM input Input / Observe

EN External DRV2603 enable control Input / Observe

Filtered output test points for observation, connect to oscilloscope orOUT+ / OUT- Outputmeasurement equipment

OUT Unfiltered output terminal block, connect to actuator Output

USB USB power (5V) Input

VBAT External Supply Power (2.5V-5.2V) Input

SBW MSP430 programming header Input / Output

I2C MSP430 I2C™ bus Input / Output
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Table 2. Hardware Overview (continued)

Signal Description I/O

The audio jack is connected to an ADC on the MSP430. This is used forAudio Inputaudio-to-haptics conversion using special software on the MSP430.

Hardware configuration details can be found in the following sections.

3.2 Power Supply Selection

The DRV2603EVM-CT can be powered by USB or an external power supply (VBAT). Jumpers “DRV” and
“MSP” are used to select USB or VBAT for the DRV2603 and MSP430G2553, respectively. See the
following table for possible configurations.

Supply Configuration DRV MSP DRV2603 Supply Voltage (1)

USB – Both USB USB 5V

DRV2603 External Supply, MSP430 VBAT USB VBATUSB

External Supply - Both VBAT VBAT VBAT

USB with 3.3V LDO (2) - Both USB USB 3.3V (R4 = Short, R5 = Open)
(1) The DRV2603 supply must be on before operating the MSP430.
(2) If a 3.3V DRV2603 supply voltage is preferred while using the USB as the power source, remove R5 and add a zero ohm

resistor across R4.

3.3 Using an External Actuator

Figure 8. Terminal Block and Test Points

The DRV2603EVM-CT can be used with an external actuator. Follow the instructions below to attach an
actuator to the "OUT" terminal block.

1. Remove jumpers JP3 and JP4, which will disconnect the on-board actuators from the DRV2603.

2. Attach the positive and negative leads of the actuator to the green “OUT” terminal block keeping in
mind polarity.

3. Screw down the terminal block to secure the actuator leads.

It is important to use the green terminal block when connecting an external actuator. The "OUT+" and
"OUT-" testpoints have low-pass filters and should only be used for oscilloscope and bench
measurements.
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3.4 PWM Input Source

Figure 9. External PWM Input

The DRV2603 input signal can be driven by the on-board MSP430 PWM or an external PWM source. The
input source is selected by shorting or disconnecting JP1.

JP1 PWM Source

Shorted MSP430

Open External PWM using PWM testpoint

To set the DRV2603 enable pin high while using an external PWM source:

1. Enter Additional Hardware Modes by holding the "+" button until the actuator buzzes and the mode
LEDs blink.

2. Select Mode 3 (00011'b) using the increment mode button ("+").

3. In Mode 3, press one of the following buttons to enable the DRV2603.

• B1 - disable the DRV2603

• B2 - enable with LRA auto-resonance on

• B3 - enable with LRA auto-resonance off

• B4 - enable in ERM mode

4. If the DRV2603 is enabled, the "EN" LED will glow.
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3.5 Enable Pin Source

Figure 10. External Enable

The enable pin on the DRV2603 is controlled by the MSP430. To use an external control source or GPIO
there are two options.

Using the Additional Hardware Modes in the MSP430 firmware, select "Mode 5" which will Hi-Z the
MSP430 I/O enable control pin so it does not interfere with the external enable control source.

1. Enter Additional Hardware Modes by holding the "+" button until the actuator buzzes and the mode
LEDs blink.

2. Select Mode 5 (00101'b) using the increment mode button ("+").

3. Connect the external control source to the EN test point at the top of the board.

4. In Mode 5, press one of the following buttons to Hi-Z the DRV2603 enable (EN) pin.

• B1 - disable Hi-Z mode

• B2 - Hi-Z MSP430 EN pin, select LRA auto-resonance on

• B3 - Hi-Z MSP430 EN pin, select LRA auto-resonance off

• B4 - Hi-Z MSP430 EN pin, select ERM mode

To physically disconnect the MSP430 from the DRV2603 enable pin:

1. Remove resistor R8 which disconnects the MSP430 from the DRV2603.

2. Connect the external control source to the EN test point at the top of the board.
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3.6 LRA/ERM Mode Source

Figure 11. Hardware Select Actuator Mode

The DRV2603EVM-CT includes both an LRA and ERM actuator. By default, the MSP430 firmware will
apply the appropriate logic voltage to the DRV2603 actuator select pin (LRA/ERM) and select the
appropriate actuator using an on-board load switch (U5).

To manually select the on-board actuator using the MSP430 firmware:

1. Enter Additional Hardware Modes by holding the "+" button until the actuator buzzes and the mode
LEDs blink.

2. Select Mode 3 (00011'b) using the increment mode button ("+").

3. In Mode 3, press one of the following buttons to enable the DRV2603 and select the appropriate
actuator.

• B1 - disable the DRV2603

• B2 - select the on-board LRA and enable the DRV2603

• B3 - select the on-board LRA and enable the DRV2603

• B4 - select the on-board ERM and enable the DRV2603

4. If the DRV2603 is enabled, the "EN" LED will glow.

To manually set the actuator select pin using hardware, use resistors R1, R2, and R3 to configure the
DRV2603 .

1. Remove resistor R1, which will disconnect the MSP430.

2. To select LRA mode, add a 0Ω resistor across R2 which will short the pin to VBAT.

3. To select ERM mode, add a 0Ω resistor across R3 which will short the pin to ground.

To manually select either the on-board ERM or LRA actuator using hardware:

1. Remove resistor R34 which will disconnect the MSP430.

2. To select the LRA, place a 0Ω resistor across R35.

3. To select the ERM, no additional resistors are needed.
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Actuator Selection Resistor Configurations

Actuator Type R1 R2 R3 R34 R35

ERM Open Open 0Ω Open Open

LRA Open 0Ω Open Open 0Ω
External ERM Open Open 0Ω X (1) X (1)

External LRA Open 0Ω Open X (1) X (1)

(1) Does not matter

4 Measurement and Analysis

4.1 Output Measurements

The DRV2603 uses PWM modulation to create the output signal for both ERM and LRA actuators. To
measure and observe the DRV2603 output waveform, connect an oscilloscope or other measurement
equipment to the filtered output test points, “OUT+” and “OUT-“.

Figure 12. Terminal Block and Test Points

The DRV2603 drives LRA and ERM actuators using a 20kHz PWM modulated waveform, but only the
frequencies around the LRA resonant frequency or the ERM DC drive voltage are relevant to the haptic
actuator vibration. The higher frequency switching content does not contribute to the vibration strength of
the actuator and can make it difficult to interpret the modulated output waveform on an oscilloscope. The
oscilloscope image on the left shows the DRV2603 unfiltered waveform and the image on the right shows
a filtered version used for observation and measurement.

Figure 13. DRV2603 Unfiltered Waveform Figure 14. DRV2603 Filtered Waveform

To observe the modulated output waveform and ensure that the 20kHz switching waveform and
associated harmonics are not captured, use either a digital or analog, low pass filter when viewing the
output waveform. TI recommends using a 1st-order, low-pass filter with a cutoff between 1kHz and
3.5kHz.

Below are recommended output filters for use while measuring and characterizing the DRV2603. Certain
oscilloscopes have a built-in digital, low-pass filter, so no external components are required.
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Figure 15. Measuring the DRV2603 Output with a Digital Low-pass Filter

An analog 1st order, low-pass, RC filter can also be used; however, care must be taken not to use a filter
impedance that is too low. Low filter impedance can affect the back-EMF of the actuator and interfere with
the auto-resonance detection algorithm. See the recommend values in Figure 16.

Figure 16. Measuring the DRV2603 Output Signal with an Analog Low-pass Filter

5 MSP430 Control and Firmware

The DRV2603EVM-CT is controlled by a programmable MSP430. This section contains information for
programming and controlling the board using the MSP430.

5.1 Additional Hardware Modes

Additional modes are available on the DRV2603EVM-CT that provide increased board control and
functionality. The additional modes are not available in “demo” mode, but can be access by switching to
“binary counting mode”. In “binary counting mode” the mode LEDs count in binary (32 modes) rather than
in “demo” mode format (only 6 modes including off).

5.1.1 Enter Binary Counting Mode

To enter “binary counting mode” and access the additional modes:

1. Press and hold the increment mode button (“+”) for approximately 3 seconds.

2. Release the button when the actuator buzzes and the mode LEDs flash.

3. Select from the “binary counting modes” using the “+” and “-“ buttons.

All modes, including “demo” modes, are available in binary counting mode, see Table 3 for a description.

5.1.2 Exit Binary Counting Mode

To exit “binary counting mode” and return to “demo” mode:

1. Press and hold the decrement mode button (“-“) for approximately 3 seconds.

2. Release the button when the actuator buzzes and mode LEDs flash.

3. Select from the “demo” modes using the “+” and “-“ buttons.
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5.1.3 Binary Counting Modes

Table 3 lists the modes available in “binary counting mode”. The same modes in “demo” mode are present
in “binary counting mode”.

Table 3. Binary Counting Modes

Mode Button Description Actuator Mode Notes

Mode 0 Ramp and Clicks. See Table 1 Mode 0.

Mode 1 Concentration Game. See Table 1 Mode 5.

Mode 2 ERM Clicks. See Table 1 Mode 4.

B1 Disable Amplifier External PWM - Apply an
external PWM source toB2 Enable DRV2603 LRA (Auto-Resonance On)Mode 3 the PWM testpoint, useExternal PWM B3 Enable DRV2603 LRA (Auto-Resonance Off) MSP430 for hardwareLEDs: 00011 configuration. Remove

B4 Enable DRV2603 ERM jumper JP1.

Mode 4 LRA Keyboard and Mouse Effects. See Table 1 Mode 3.

B1 Disable Amplifier External PWM / External
Mode 5 Enable - Apply an externalB2 Enable DRV2603 LRA (Auto-Resonance On)
External PWM and External PWM source and enable

B3 Enable DRV2603 LRA (Auto-Resonance Off)Enable signal. Enable pin on
LEDs: 00101 MSP430 is Hi-Z. Remove

B4 Enable DRV2603 ERM jumper JP1.

B1 Begin Life Test Life Test (2 seconds on, 1
second off) - life testB2 Test Buzz
repeats infinite times andMode 6 Decrease output voltage board must be poweredB3Life Test (LRA) LRA (Auto-resonance On)(+1 increment) down to stop. Increment /LEDs: 00110 Decrement amplitude using

Increase output voltage (+1 B3 and B4. Test newB4 increment) amplitude using B2.

B1 Begin Life Test Life Test (Infinite Buzz) -
board must be poweredB2 Test Buzz
down to stop buzz.Mode 7 Decrease output voltage Increment / DecrementB3Life Test Buzz (LRA) LRA (Auto-resonance On)(+1 increment) amplitude using B3 and B4.LEDs: 00111 Test new amplitude using

Increase output voltage (+1 B2 before beginning lifeB4 increment) test.

Mode 8 LRA Clicks. See Table 1 Mode 2

B1 Alert (Auto-resonance On) LRA (Auto-resonance On) Vary the auto-resonance off
output frequency and seeB2 Alert (Auto-resonance Off)Mode 9 the change in vibrationAuto-resonance off B3 Decrease output frequency force over frequency.frequence adjust LRA (Auto-resonance Off) Compare B2 (auto-LEDs: 01001 resonance off) with B1B4 Increase output frequence
(auto-resonance on).

B1 Begin Life Test Life Test (Infinite Buzz) -
board must be poweredB2 Test Buzz
down to stop buzz.Mode 10 Decrease output voltage Increment / DecrementB3Life Test Buzz (ERM) ERM(+1 increment) amplitude using B3 and B4.LEDs: 01010" Test new amplitude using

Increase output voltage (+1 B2 before beginning lifeB4 increment) test.

Mode 16 Alerts. See Table 1 Mode 1.
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5.2 Modifying or Reprogramming the Firmware

The MSP430 firmware on the DRV2603EVM-CT can be modified or reprogrammed to create new haptic
effects or behaviors. Find the latest firmware source code and binaries on TI.com. Follow the instructions
below to modify or reprogram the DRV2603EVM-CT.

1. Purchase one of the following MSP430G2553 compatible programmers:

• EZ430-F2013 (recommended)

• MSP-EXP430G2 (recommended) - requires the additional purchase of a header for J4

– Digi-Key: ED8650-ND

– Mouser: 575-500201

• MSP430-FET430UIF - requires a JTAG to Spy-Bi-Wire adapter (MSP-JTAGSBW if available)

2. Download and install Code Compose Studio (CCS) or IAR Embedded Workbench IDE.

3. Download the DRV2603EVM-CT source code and binaries from TI.com.

4. Connect the programmer to an available USB port.

5. Connect the programmer to the “SBW” header on the DRV2603EVM-CT.

6. In CCS,

(a) Open the project file by selecting Project > Import Existing CCS Project.

(b) Select Browse and navigate to the DRV2603EVM-CT project folder, then press OK.

(c) Select the checkbox next to the DRV2603EVM-CT project in the “Discovered projects” window and
then press “Finish”.

(d) Before compiling, navigate to Project > Properties > Build > MSP430 Compiler > Advanced Options
> Language Options and make sure the checkbox for “Enable support for GCC extensions (--gcc)”
is checked.

7. In IAR,

(a) Create a new MSP430 project in IAR,

(b) Select the MSP430G2553 device,

(c) Copy the files in the project folder downloaded from TI.com to the new project directory.
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5.3 MSP430 Pin-Out

The DRV2603EVM-CT contains a MSP430G2553 low-cost microcontroller which controls the board and
contains sample haptic effects. The pin-out for the microcontroller can be found in Table 4.

Table 4. MSP430 Pin-Out

# Label Description

1 P1.1 Green LED

2 P1.2 Yellow LED

3 P1.3 Blue LED

4 P1.4 VREF+

5 P1.5 Audio-to-Haptics

6 P3.1 Enable

7 P3.0 Actuator Mode Selection

8 NC

9 P2.0 Button 1

10 P2.1 Button 2

11 P2.2 Button 3

12 P3.2 PWM

13 P3.3 WLED 0

14 P3.4 WLED 1

15 P2.3 Button 4

16 P2.4 "+" Button

17 P2.5 "–" Button

18 P3.5 WLED 2

19 P3.6 WLED 3

20 P3.7 WLED 4

21 P1.6/SCL I2C Clock

22 P1.7/SDA I2C Data

23 SBWTDIO Spy-Bi-Wire Data

24 SBWTCK Spy-Bi-Wire Clock

25 P2.7

26 P2.6 LRA/ERM Load Switch

27 AVSS Analog Ground

28 DVSS Digital Ground

29 AVCC Analog Supply

30 DVCC Digital Supply

31 P1.0 Red LED

32 NC
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Figure 17. X-Ray Top View

Figure 18. Top Copper
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Figure 19. Layer 2 Copper

Figure 20. Layer 3 Copper
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Figure 21. Bottom Copper
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8 Bill of Materials

ITEM MANU PARTNUM QTY REF DESIGNATORS VENDOR PARTNUM DESCRIPTION VENDOR MANUFACTURER

SEMICONDUCTORS

1 DRV2603RUN 1 U1 DRV2603RUN NO DATA YET QFN10-RUN ROHS TEXAS TEXAS
INSTRUMENTS INSTRUMENTS

2 TXS0102DCTR 1 U4 296-21978-1 2-BIT BIDIR LEVEL TRANSLATOR DIGI-KEY TEXAS
SSOP8-DCT ROHS INSTRUMENTS

3 MSP430G2553IRHB32 1 U2 595- MIXED SIGNAL MICRO 16KB MOUSER TEXAS
T P430G2553IRHB32T FLASH 512B RAM QFN32-RHB INSTRUMENTS

ROHS

4 TPS73633MDBVREP 1 U3 296-21283-1 VOLT REG 3.3V 400MA LDO CAP DIGI-KEY TEXAS
FREE NMOS SOT23-DBV5 ROHS INSTRUMENTS

5 TS5A12301EYFPR 1 U5 296-23757-1-ND IEC LEVEL 4 ESD-PROTECTED DIGI-KEY TEXAS
0.75-OHM ANALOG SWITCH INSTRUMENTS
WCSP6-YFP ROHS

6 LTST-C190KGKT 2 5V,EN 160-1435-1-ND LED,GREEN,2.0V,SMD0603,ROHS DIGI-KEY LITE-ON INC.

7 LNJ037X8ARA 5 M0,M1,M2,M3,M4 LNJ037X8ARACT-ND LED, WHITE 2.9V SMD0805 ROHS DIGI-KEY PANASONIC

8 SML-LXT0805SRW-TR 1 B1 67-1555-1 LED, RED 2.0V SMD0805 ROHS DIGI-KEY LUMEX OPTO

9 SML-LXT0805GW-TR 1 B2 67-1553-1 LED, GREEN 2.0V SMD0805 ROHS DIGI-KEY LUMEX OPTO

10 SML-LXT0805YW-TR 1 B3 67-1554-1 LED, YELLOW 2.0V SMD0805 DIGI-KEY LUMEX OPTO
ROHS

11 LTST-C171TBKT 1 B4 160-1645-1-ND LED, BLUE 3.3V SMD0805 ROHS DIGI-KEY LITE-ON INC.

CAPACITORS

12 GRM155R71C104KA8 2 C1,C12 490-3261-1-ND CAP SMD0402 CERM 0.1UFD 16V DIGI-KEY MURATA
8D X7R 10% ROHS

13 C1005X5R0J104K 4 C8,C9,C10,C13 445-1266-1 CAP SMD0402 CERM 0.1UFD 6.3V DIGI-KEY TDK CORP
10% X5R ROHS

14 0805YD106KAT2A 1 C6 478-5165-1 CAP SMD0805 CERM 10UFD 16V DIGI-KEY AVX
X5R 10% ROHS

15 GRM155R60J105KE19 1 C7 490-1320-1 CAP SMD0402 CERM 1.0UFD 6.3V DIGI-KEY MURATA
D X5R 10% ROHS

16 GRM188R60J106ME4 1 C11 490-3896-1-ND CAP SMD0603 CERM 10UFD 6.3V DIGI-KEY MURATA
7D 20% X5R ROHS

17 C0402C471K5RACTU 2 C14,C15 399-1025-1 CAP SMD0402 CERM 470PFD 50V DIGI-KEY KEMET
10% X7R ROHS

18 TCTAL0J107M8R 1 C5 511-1498-1-ND CAP TANT1206 100UFD 6.3V 20% DIGI-KEY ROHM
TCT SERIES ROHS
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ITEM MANU PARTNUM QTY REF DESIGNATORS VENDOR PARTNUM DESCRIPTION VENDOR MANUFACTURER

RESISTORS

19 ERJ-2GEJ821 1 R45 RESISTOR,SMT,0402,THICK
FILM,5%,1/16W,820

20 ERJ-2RKF9761X 1 R7 P9.76KLCT-ND RESISTOR SMD0402 THICK FILM DIGI-KEY PANASONIC
9.76K OHMS 1/10W 1% ROHS

21 RMCF0402ZT0R00 6 R1,R8,R32,R33,R34,R RMCF0402ZT0R00CT ZERO OHM JUMPER SMT 0402 0 DIGI-KEY STACKPOLE
36 OHM 1/16W,5% ROHS ELECTRONICS

22 RC0402FR-07511RL 5 R9,R11,R12,R13,R14 311-511LRCT-ND RESISTOR SMD0402 THICK FILM DIGI-KEY YAGEO
511 OHMS 1% 1/16W ROHS

23 ERJ-2GEJ152 1 R26 RESISTOR,SMT,0402,THICK Panasonic
FILM,5%,1/16W,1.5K

24 RMCF0603ZT0R00 1 R5 RMCF0603ZT0R00CT- RESISTOR SMD0603 ZERO OHMS DIGI-KEY STACKPOLE
ND 1/10W ROHS ELECTRONICS

25 ERJ-2RKF2490X 5 R15,R16,R17,R18,R19 P249LTR-ND RESISTOR,SMT,0402,249 DIGI-KEY Panasonic
OHM,1%,1/16W

26 ERJ-2RKF4992X 2 R43,R44 P49.9KLCT RESISTOR SMD0402 THICK FILM DIGI-KEY PANASONIC
49.9K OHMS 1/16W 1% ROHS

27 CRCW04020000Z0ED 2 R40,R46 541-0.0JCT ZERO OHM JUMPER SMT 0402 0 DIGI-KEY VISHAY
OHM 1/16W,5% ROHS

28 ERJ-2GEJ104 2 R50,R51 P100KJCT RESISTOR SMD0402 THICK FILM DIGI-KEY PANASONIC
100K OHMS 1/16W 5% ROHS

FERRITE BEADS

29 MPZ2012S601A 2 FB1,FB2 445-2206-1 FERRITE BEAD SMD0805 600 DIGI-KEY TDK
Ohms 2A ROHS

HEADERS, JACKS, AND SHUNTS

30 LPPB061NGCN-RC 1 SBW S9010E-06 HEADER THRU FEMALE 1X6-RA DIGI-KEY SULLINS
50LS GOLD ROHS

31 PBC03SAAN 3 DRV,I2C,MSP S1011E-03-ND HEADER THRU MALE 3 PIN 100LS DIGI-KEY SULLINS
GOLD ROHS

32 PBC02SAAN 1 JP2 S1011E-02 HEADER THRU MALE 2 PIN 100LS DIGI-KEY SULLINS
GOLD ROHS

33 PBC02SAAN 3 JP1,JP3,JP4 HEADER THRU MALE 2 PIN 100LS DIGI-KEY SULLINS
GOLD ROHS

34 UX60-MB-5ST 1 USB H2959CT JACK USB MINIB SMT-RA 5PIN DIGI-KEY HIROSE
ROHS

35 SJ-3523-SMT 1 Audio CP-3523SJCT-ND JACK AUDIO-STEREO MINI(3.5MM DIGI-KEY CUI STACK
,3-COND SMT-RA ROHS

36 SPC02SYAN 6 MSP (2-3), DRV (2-3), S9001-ND SHUNT BLACK AU FLASH 0.100LS DIGI-KEY SULLINS
JP1, JP2, JP3, JP4 CLOSED TOP ROHS

37 1725656 2 OUT,VBAT 277-1273 TERMINAL BLOCK MPT DIGI-KEY PHOENIX CONTACT
COMBICON 2PIN 6A/125V GREEN
100LS ROHS
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ITEM MANU PARTNUM QTY REF DESIGNATORS VENDOR PARTNUM DESCRIPTION VENDOR MANUFACTURER

TESTPOINTS AND SWITCHES

38 5003 4 ENIN,OUT+,OUT- 5003K PC TESTPOINT, ORANGE, ROHS DIGI-KEY KEYSTONE
,EXTIN (Solder so that ELECTRONICS
color ring is secured)

39 5011 2 GND,TP1 (Solder so 5011K PC TESTPOINT BLACK 063 HOLE DIGI-KEY KEYSTONE
that color ring is ROHS ELECTRONICS
secured)

40 NRS-2574 1 AVM1 NRS-2574 ACUTATOR VIBRATION MOTOR SANYO SANYO
1,3V 9000 RPM ROHS

41 ELV1036A 1 - - ACTUATOR - LINEAR VIBRATOR, AAC AAC
2VRMS

42 - 1 - - Metal Block (Custom Block, Heavy Heavy Metal Heavy Metal
Metal, See metal block spec)

43 3-5-468MP 1 - 3M9724-ND TAPE TRANSFER ADHESIVE 3" X DIGI-KEY 3M
5YD

44 2-5-4466W 1 - 3M9962-ND TAPE POLY FOAM 2" x 5YD DIGI-KEY 3M

COMPONENTS NOT ASSEMBLED

45 R0402_DNP 11 R2,R3,R20,R21,R22,R R0402_DNP
23,R24,R25,R30,R31,
R35

46 TestPoint_SMD- 2 LRA_OUT+,LRA_OUT- TESTPOINT SMD SQUARE 2.0mm
Square_2.0mm

47 R0603_DNP 1 R4 RMCF0603ZT0R00CT- R0603_DNP DIGI-KEY STACKPOLE
ND ELECTRONICS

48 R0402_DNP 2 R41,R47 P4.99KLCT-ND R0402_DNP DIGI-KEY PANASONIC

49 R0402_DNP 1 R42 541-0.0JCT R0402_DNP DIGI-KEY VISHAY
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EVALUATION BOARD/KIT/MODULE (EVM) ADDITIONAL TERMS

Texas Instruments (TI) provides the enclosed Evaluation Board/Kit/Module (EVM) under the following conditions:

The user assumes all responsibility and liability for proper and safe handling of the goods. Further, the user indemnifies TI from all claims
arising from the handling or use of the goods.

Should this evaluation board/kit not meet the specifications indicated in the User’s Guide, the board/kit may be returned within 30 days from
the date of delivery for a full refund. THE FOREGOING LIMITED WARRANTY IS THE EXCLUSIVE WARRANTY MADE BY SELLER TO
BUYER AND IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED, IMPLIED, OR STATUTORY, INCLUDING ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE. EXCEPT TO THE EXTENT OF THE INDEMNITY SET FORTH
ABOVE, NEITHER PARTY SHALL BE LIABLE TO THE OTHER FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES.

Please read the User's Guide and, specifically, the Warnings and Restrictions notice in the User's Guide prior to handling the product. This
notice contains important safety information about temperatures and voltages. For additional information on TI's environmental and/or safety
programs, please visit www.ti.com/esh or contact TI.

No license is granted under any patent right or other intellectual property right of TI covering or relating to any machine, process, or
combination in which such TI products or services might be or are used. TI currently deals with a variety of customers for products, and
therefore our arrangement with the user is not exclusive. TI assumes no liability for applications assistance, customer product design,
software performance, or infringement of patents or services described herein.

REGULATORY COMPLIANCE INFORMATION

As noted in the EVM User’s Guide and/or EVM itself, this EVM and/or accompanying hardware may or may not be subject to the Federal
Communications Commission (FCC) and Industry Canada (IC) rules.

For EVMs not subject to the above rules, this evaluation board/kit/module is intended for use for ENGINEERING DEVELOPMENT,
DEMONSTRATION OR EVALUATION PURPOSES ONLY and is not considered by TI to be a finished end product fit for general consumer
use. It generates, uses, and can radiate radio frequency energy and has not been tested for compliance with the limits of computing
devices pursuant to part 15 of FCC or ICES-003 rules, which are designed to provide reasonable protection against radio frequency
interference. Operation of the equipment may cause interference with radio communications, in which case the user at his own expense will
be required to take whatever measures may be required to correct this interference.

General Statement for EVMs including a radio

User Power/Frequency Use Obligations: This radio is intended for development/professional use only in legally allocated frequency and
power limits. Any use of radio frequencies and/or power availability of this EVM and its development application(s) must comply with local
laws governing radio spectrum allocation and power limits for this evaluation module. It is the user’s sole responsibility to only operate this
radio in legally acceptable frequency space and within legally mandated power limitations. Any exceptions to this are strictly prohibited and
unauthorized by Texas Instruments unless user has obtained appropriate experimental/development licenses from local regulatory
authorities, which is responsibility of user including its acceptable authorization.

For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant

Caution

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to operate the
equipment.

FCC Interference Statement for Class A EVM devices

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to
cause harmful interference in which case the user will be required to correct the interference at his own expense.

http://www.ti.com/corp/docs/csr/environment/ESHPolicyandPrinciples.shtml


FCC Interference Statement for Class B EVM devices

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment
generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If
this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

For EVMs annotated as IC – INDUSTRY CANADA Compliant

This Class A or B digital apparatus complies with Canadian ICES-003.

Changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate the
equipment.

Concerning EVMs including radio transmitters

This device complies with Industry Canada licence-exempt RSS standard(s). Operation is subject to the following two conditions: (1) this
device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired
operation of the device.

Concerning EVMs including detachable antennas

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser) gain
approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type and its gain should
be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for successful communication.

This radio transmitter has been approved by Industry Canada to operate with the antenna types listed in the user guide with the maximum
permissible gain and required antenna impedance for each antenna type indicated. Antenna types not included in this list, having a gain
greater than the maximum gain indicated for that type, are strictly prohibited for use with this device.

Cet appareil numérique de la classe A ou B est conforme à la norme NMB-003 du Canada.

Les changements ou les modifications pas expressément approuvés par la partie responsable de la conformité ont pu vider l’autorité de
l'utilisateur pour actionner l'équipement.

Concernant les EVMs avec appareils radio

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation est
autorisée aux deux conditions suivantes : (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit accepter tout
brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concernant les EVMs avec antennes détachables

Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et d'un gain
maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage radioélectrique à
l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope rayonnée équivalente
(p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante.

Le présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le manuel
d’usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne non inclus dans
cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de l'émetteur.
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【【Important Notice for Users of this Product in Japan】】
This development kit is NOT certified as Confirming to Technical Regulations of Radio Law of Japan

If you use this product in Japan, you are required by Radio Law of Japan to follow the instructions below with respect to this product:

1. Use this product in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal Affairs and
Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for Enforcement of Radio Law of
Japan,

2. Use this product only after you obtained the license of Test Radio Station as provided in Radio Law of Japan with respect to this
product, or

3. Use of this product only after you obtained the Technical Regulations Conformity Certification as provided in Radio Law of Japan with
respect to this product. Also, please do not transfer this product, unless you give the same notice above to the transferee. Please note
that if you could not follow the instructions above, you will be subject to penalties of Radio Law of Japan.

Texas Instruments Japan Limited
(address) 24-1, Nishi-Shinjuku 6 chome, Shinjuku-ku, Tokyo, Japan

http://www.tij.co.jp

【ご使用にあたっての注】

本開発キットは技術基準適合証明を受けておりません。

本製品のご使用に際しては、電波法遵守のため、以下のいずれかの措置を取っていただく必要がありますのでご注意ください。
1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。

　　　上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。

日本テキサス・インスツルメンツ株式会社
東京都新宿区西新宿６丁目２４番１号
西新宿三井ビル
http://www.tij.co.jp
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EVALUATION BOARD/KIT/MODULE (EVM)
WARNINGS, RESTRICTIONS AND DISCLAIMERS

For Feasibility Evaluation Only, in Laboratory/Development Environments. Unless otherwise indicated, this EVM is not a finished
electrical equipment and not intended for consumer use. It is intended solely for use for preliminary feasibility evaluation in
laboratory/development environments by technically qualified electronics experts who are familiar with the dangers and application risks
associated with handling electrical mechanical components, systems and subsystems. It should not be used as all or part of a finished end
product.

Your Sole Responsibility and Risk. You acknowledge, represent and agree that:

1. You have unique knowledge concerning Federal, State and local regulatory requirements (including but not limited to Food and Drug
Administration regulations, if applicable) which relate to your products and which relate to your use (and/or that of your employees,
affiliates, contractors or designees) of the EVM for evaluation, testing and other purposes.

2. You have full and exclusive responsibility to assure the safety and compliance of your products with all such laws and other applicable
regulatory requirements, and also to assure the safety of any activities to be conducted by you and/or your employees, affiliates,
contractors or designees, using the EVM. Further, you are responsible to assure that any interfaces (electronic and/or mechanical)
between the EVM and any human body are designed with suitable isolation and means to safely limit accessible leakage currents to
minimize the risk of electrical shock hazard.

3. You will employ reasonable safeguards to ensure that your use of the EVM will not result in any property damage, injury or death, even
if the EVM should fail to perform as described or expected.

4. You will take care of proper disposal and recycling of the EVM’s electronic components and packing materials.

Certain Instructions. It is important to operate this EVM within TI’s recommended specifications and environmental considerations per the
user guidelines. Exceeding the specified EVM ratings (including but not limited to input and output voltage, current, power, and
environmental ranges) may cause property damage, personal injury or death. If there are questions concerning these ratings please contact
a TI field representative prior to connecting interface electronics including input power and intended loads. Any loads applied outside of the
specified output range may result in unintended and/or inaccurate operation and/or possible permanent damage to the EVM and/or
interface electronics. Please consult the EVM User's Guide prior to connecting any load to the EVM output. If there is uncertainty as to the
load specification, please contact a TI field representative. During normal operation, some circuit components may have case temperatures
greater than 60°C as long as the input and output are maintained at a normal ambient operating temperature. These components include
but are not limited to linear regulators, switching transistors, pass transistors, and current sense resistors which can be identified using the
EVM schematic located in the EVM User's Guide. When placing measurement probes near these devices during normal operation, please
be aware that these devices may be very warm to the touch. As with all electronic evaluation tools, only qualified personnel knowledgeable
in electronic measurement and diagnostics normally found in development environments should use these EVMs.

Agreement to Defend, Indemnify and Hold Harmless. You agree to defend, indemnify and hold TI, its licensors and their representatives
harmless from and against any and all claims, damages, losses, expenses, costs and liabilities (collectively, "Claims") arising out of or in
connection with any use of the EVM that is not in accordance with the terms of the agreement. This obligation shall apply whether Claims
arise under law of tort or contract or any other legal theory, and even if the EVM fails to perform as described or expected.

Safety-Critical or Life-Critical Applications. If you intend to evaluate the components for possible use in safety critical applications (such
as life support) where a failure of the TI product would reasonably be expected to cause severe personal injury or death, such as devices
which are classified as FDA Class III or similar classification, then you must specifically notify TI of such intent and enter into a separate
Assurance and Indemnity Agreement.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2012, Texas Instruments Incorporated



IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, modifications, enhancements, improvements,
and other changes to its products and services at any time and to discontinue any product or service without notice. Customers should
obtain the latest relevant information before placing orders and should verify that such information is current and complete. All products are
sold subject to TI’s terms and conditions of sale supplied at the time of order acknowledgment.

TI warrants performance of its hardware products to the specifications applicable at the time of sale in accordance with TI’s standard
warranty. Testing and other quality control techniques are used to the extent TI deems necessary to support this warranty. Except where
mandated by government requirements, testing of all parameters of each product is not necessarily performed.

TI assumes no liability for applications assistance or customer product design. Customers are responsible for their products and
applications using TI components. To minimize the risks associated with customer products and applications, customers should provide
adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any TI patent right, copyright, mask work right,
or other TI intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information
published by TI regarding third-party products or services does not constitute a license from TI to use such products or services or a
warranty or endorsement thereof. Use of such information may require a license from a third party under the patents or other intellectual
property of the third party, or a license from TI under the patents or other intellectual property of TI.

Reproduction of TI information in TI data books or data sheets is permissible only if reproduction is without alteration and is accompanied
by all associated warranties, conditions, limitations, and notices. Reproduction of this information with alteration is an unfair and deceptive
business practice. TI is not responsible or liable for such altered documentation. Information of third parties may be subject to additional
restrictions.

Resale of TI products or services with statements different from or beyond the parameters stated by TI for that product or service voids all
express and any implied warranties for the associated TI product or service and is an unfair and deceptive business practice. TI is not
responsible or liable for any such statements.

TI products are not authorized for use in safety-critical applications (such as life support) where a failure of the TI product would reasonably
be expected to cause severe personal injury or death, unless officers of the parties have executed an agreement specifically governing
such use. Buyers represent that they have all necessary expertise in the safety and regulatory ramifications of their applications, and
acknowledge and agree that they are solely responsible for all legal, regulatory and safety-related requirements concerning their products
and any use of TI products in such safety-critical applications, notwithstanding any applications-related information or support that may be
provided by TI. Further, Buyers must fully indemnify TI and its representatives against any damages arising out of the use of TI products in
such safety-critical applications.

TI products are neither designed nor intended for use in military/aerospace applications or environments unless the TI products are
specifically designated by TI as military-grade or "enhanced plastic." Only products designated by TI as military-grade meet military
specifications. Buyers acknowledge and agree that any such use of TI products which TI has not designated as military-grade is solely at
the Buyer's risk, and that they are solely responsible for compliance with all legal and regulatory requirements in connection with such use.

TI products are neither designed nor intended for use in automotive applications or environments unless the specific TI products are
designated by TI as compliant with ISO/TS 16949 requirements. Buyers acknowledge and agree that, if they use any non-designated
products in automotive applications, TI will not be responsible for any failure to meet such requirements.

Following are URLs where you can obtain information on other Texas Instruments products and application solutions:

Products Applications

Audio www.ti.com/audio Automotive and Transportation www.ti.com/automotive

Amplifiers amplifier.ti.com Communications and Telecom www.ti.com/communications

Data Converters dataconverter.ti.com Computers and Peripherals www.ti.com/computers

DLP® Products www.dlp.com Consumer Electronics www.ti.com/consumer-apps

DSP dsp.ti.com Energy and Lighting www.ti.com/energy

Clocks and Timers www.ti.com/clocks Industrial www.ti.com/industrial

Interface interface.ti.com Medical www.ti.com/medical

Logic logic.ti.com Security www.ti.com/security

Power Mgmt power.ti.com Space, Avionics and Defense www.ti.com/space-avionics-defense

Microcontrollers microcontroller.ti.com Video and Imaging www.ti.com/video

RFID www.ti-rfid.com

OMAP Mobile Processors www.ti.com/omap

Wireless Connectivity www.ti.com/wirelessconnectivity

TI E2E Community Home Page e2e.ti.com

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2012, Texas Instruments Incorporated
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